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PROGRAM CONVENTIONS 

SNAP Main Menus 
 
The menu in SNAP consists of 4 options: File, Units, and Help (Figure 6.)  
 

 
 

Figure 6.  Screen Shot.  SNAP main menus. 
 

File Menu Items 
 
The File menu contains standard operations found in other Windows-based computer programs: 
New, Open, Save..., Save As…, and Exit  (Figure 7).  The Rename operation allows the user to 
rename the current file, by right-clicking on the folder name.  The Clear Data operation will 
erase all the inputs in the current file so the user can start over.  The Default Data operation fills 
data fields with values for Example 1 (the complete Example work-through can be found in 
Chapter 4). 
 

 
 

Figure 7.  Screen Shot.  File menu items. 
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Units Menu Items 
 
The Units menu allows the user to enter project data in either Customary US units (i.e. ft, lbf, 
psi, etc.) or SI units (i.e. m, N, kPa, etc.) (Figure 8).  The default setting for a new project is 
Customary US units.  If the user has input data in SI units and accidentally enters those values 
while the units are set to US units, then the user can simply select SI from the units menu.  The 
input values will remain the same, but the program will perform calculations in SI units.   
 

 
 

Figure 8.  Screen Shot.  Units menu items. 
 
Convert to US and Convert to SI are used when the user has entered data in US units and now 
wants to see the equivalent problem in SI units.  For example, after entering a unit weight of 110 
lb/ft3, when the user selects Convert to SI, this will be converted to 17.28 kN/m3.  The SI units 
designation in the top part of the menu will then be automatically checked.  Please be aware that 
repeatedly converting back and forth between US and SI units will result in slight round-off 
errors.  

Help Menu Items 
 
On the Help menu, select Topics to open the Help file’s Table of Contents.   
 

 
 

Figure 9.  Screen Shot.  Help menu items. 
 
The Help function is navigated by clicking on links in the Table of Contents listing, and clicking 
on Return to Table of Contents and other links within each Help section.  No Search function is 
currently available.  To hide Help, drag the frame all the way to the right side of your screen 
(Figure 10) 
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Figure 10.  Screen Shot.  Show/hide the Help frame.  
At any time, selecting Help � About from the main menu provides version information.  

Toolbar 
 
The toolbar at the top of the screen (Figure 11) gives access to common menu commands, 
including: 

� File �New Input File 
� File �Open 
� File �Save 
� File �Save As 
� Help �Help Topics 

 

 
 

Figure 11.  Screen Shot.  Toolbar. 
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Tabs and Option Selection 
 
Input parameters and output results in SNAP are organized into a series of tabs and sub-tabs.  
These tabs are used for organizing inputs and outputs (outputs are shown shaded in green).  In 
addition to the tabs, some options can be changed by selecting radio buttons within the tabs 
(Figure 12).  For example, under the Wall Facing tab, the user must select either Shotcrete or 
Cast-in-Place facing type.  When Shotcrete is selected, two sub-tabs appear listing the inputs and 
outputs for that facing type.  When Cast-in-Place is selected, two sub-tabs appear listing the 
inputs and outputs for the cast-in-place concrete and for the headed stud connection system.   
 

     
 

Figure 12.  Screen Shot.  Selecting tabs, radio buttons, and sub-tabs. 
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Problem Geometry 
 
In SNAP, the soil nail wall face is on the left, with the global failure occurring from right to left 
on the screen.  The coordinate system in SNAP is 3-dimensional so the user can view 3D 
graphics.  However, a 2D view is always available by tilting or spinning the graphical wall 
representation until it returns to its original position on the screen.  In 2D, the X-axis is along the 
bottom of the wall, and the Z axis is the vertical axis (Figure 13).  The toe of the wall (at the 
ground surface) is always located at the origin point, (X, Z) = (0,0).  Problem geometry is 
therefore entered in X,Z coordinates.  The Y-axis forms the base of the wall in the 3D view; no 
problem geometry is entered for the Y-axis.  See the Graphics section on page 24 for more 
information.   

 
Figure 13.  Schematic.  Problem geometry in SNAP. 

 

Origin 
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Additional Navigation Information 

 
Many input parameters in SNAP are shown with a mathematical variable in the left column.  
When the mouse is placed over the box with the variable, a more detailed description of what the 
variable stands for will appear after a few seconds:  
 

 
 

Figure 14.  Screen Shot.  Hovering over a variable will show its description. 
 
Additionally there is a complete list of parameter descriptions used in SNAP under Parameter 
Descriptions in the Help section. 
 
When more information is available about one of the output results, or a serviceability check 
does not pass minimum FHWA criteria, an icon will appear to the right of that result.  This icon 
may be a blue “information” bubble or a yellow “caution” icon:   
 

 
 

Figure 15.  Screen Shot.  Blue icons display additional information. 
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Figure 16.  Screen Shot.  Yellow icons display warnings for Factors of Safety or 
serviceability. 
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PROGRAM EXECUTION 

Quick Introduction  
 
Click on the desktop icon to start SNAP.  The program will take several minutes to start up.  A 
“splash screen” is displayed during program initialization each time the program runs; a 
“Loading” progress indicator is shown at the bottom: 

 

 
 

Figure 17.  Screen Shot.  Splash screen shown on startup. 
 
 
The program loads showing the Project tab.  For an immediate example of how the program 
looks and works, select “Example 1” from the File menu for a sample data set like that shown in  
8.  This example is discussed in further detail in Chapter 4.   
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Figure 18.  Screen Shot.  Select “Example 1” to see how the program works using sample 
data. 

 
You can now go through each tab to see what typical inputs and outputs might be.  Select the 
Report tab to generate a sample report (Figure 19).  Please wait until the report generation is 
complete.  This may require up to a minute.  A progress indicator will be displayed at the bottom 
of the screen.  After clicking a different tab and then clicking the Report tab again, the program 
will re-generate the report, assuming some inputs or outputs may have changed. 
 

 

 
 

Figure 19.  Screen Shot.  Generate a sample report by clicking on the “Report” tab. 
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Create a New Project 
 
To start from scratch and create a new project file, Select File � New: 
 

 
 

Figure 20.  Screen Shot.  Create a new project file from scratch. 
 
You can browse to the location where you would like your new project to be stored, or just click 
on the default SNAP folder (located where you installed SNAP), and select Make New Folder to 
create a new project. 
 

 
 

Figure 21.  Screen Shot.  Select “Make New Folder” to create a new project. 
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A new folder will appear: 
 

 
 

Figure 22.  Screen Shot.  A new project folder, ready to be renamed. 
 
Type in a new project name, such as Rocky Mountain National Park, and click OK: 
 

 
 

Figure 23.  Screen Shot.  Type a new name for your new project. 
 
Now you can begin filling in the input data for your new project.   
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GRAPHICS 

Summary of Graphical Presentation 

 
SNAP displays the soil nail wall in three dimensions, but all analyses are done in two 
dimensions.  Display capabilities can be useful for producing reports and presentations.   
Figure 24 summarizes how the various scroll bars surrounding the display area can be used to 
manipulate the image and see all aspects of a soil nail wall.  The axes will automatically adjust as 
the image is manipulated.  You can always go back to a 2D display by moving the Tilt and Spin 
scroll bars back to their original positions in the center.   
 

 
 

Figure 24.  Screen Shot.  Six scroll bars surrounding the display control the zoom, pan, tilt, 
and spin. 
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Zoom enlarges the image on your screen: 
 

 
 

Figure 25.  Screen Shot.  Zoom in to see the problem geometry more easily. 
 
 

Zoom in 
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Tilt rotates the image about the X-Axis: 
 

 
 

Figure 26.   Screen Shot.  Tilt will show the ground surface above the wall, or the view from 
below the wall. 

 
 



CHAPTER 2 – SNAP INPUT PARAMETERS 

27 

Spin rotates the image about the Z-Axis: 
 

 
 

Figure 27.  Screen Shot.  You can “spin” the image to see the wall facing or view the 
stability analysis from left to right. 

 
 
“Move X,” “Move Y,” and “Move Z” translate the image along the corresponding axis, without 
tilting, zooming, or spinning.  This is similar to Pan commands in other programs (e.g. 
AutoCAD). 
 

INPUT TABS 

Project 
 
The Project tab contains basic information about the project you are working on, such as the 
Name, Number, and Location.  When the Report is generated, this information will be displayed 
on every page.  
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Figure 28.  Screen Shot.  Enter basic information about your problem on the Project tab. 
 
Select the Geometry tab to enter data for the wall and backslope.  Hold the mouse over any 
variable to see a description of that input parameter, such as Wall height for H (there is also a list 
of parameter descriptions used in SNAP under Parameter Descriptions in the Help section). 
 

 
 

Figure 29.  Screen Shot.  Hold the mouse pointer over a variable to see its description. 
 
The Geometry tab includes three sub-tabs: Down Slope, Wall, and Back Slope.  For each of these 
geometry segments, the user must select one of two data entry methods: point-by-point using 
X,Z coordinates (Coordinates radio button) or by entering the horizontal distance and angle from 
horizontal for each segment (Angle-Length radio button (Figure 31). When Coordinates are 
chosen, the program will automatically fill in the Angle-Length numbers, and vice-versa.  For 
any geometry segment, points may also be added by clicking in the display area at the location a 
point is desired, or deleted by right-clicking on the yellow dot at that point.  Points may also be 
moved by clicking and dragging them around the display area.   
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Figure 30.  Screen Shot.  The problem geometry can be entered using X,Z coordinates or a 
horizontal distance and angle from horizontal. 

 

 
 

Figure 31.  Screen Shot.  You can also click and drag on the pink circles to adjust the 
problem geometry. 

 
Complex slope geometry may be added in this way; however, only single-tier walls are available.   
 
The program also allows a surcharge load to be specified for any ground segment behind the wall 
(in the back slope).  The surcharge is displayed graphically by yellow arrows: 
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Figure 32.  Screen Shot.  Surcharge loading on the top of the wall is shown by yellow 

arrows. 
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Soil Layers 
 
Select the Soil tab to enter soil strength data, pullout resistance (grout-ground bond) data, and 
bearing capacity factors. 
 

 
 
 

Figure 33.  Screen Shot.  Enter soil strength information, including pullout strength, on the 
Soil tab. 

 
The ability to model only one soil layer is provided in this version of the program.  Bearing 
capacity factors are entered by the user to allow for reductions due to an inclined toe slope, if 
required.  Qu is the ultimate pullout resistance per unit of nail length, and is calculated based on 
the hole diameter entered on the Nails tab.  
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Groundwater Data 
 
Points specifying a phreatic surface may be entered by selecting the Groundwater tab: 
 

 
 

Figure 34.  Screen Shot.  Enter phreatic surface information on the Groundwater tab. 
 
Points on the phreatic surface may be added either by entering X, Z coordinates into the table, or 
by clicking within the display area.  Groundwater is not used in external stability or facing 
(internal) stability; it is used only in global stability.  
 

Nail Data 
 
Nail geometry and strength information is entered on the Nails tab.  Nail lengths and vertical 
spacing can be either uniform or non-uniform, by selecting the radio button next to Uniform of 
Non-Uniform.  When Non-Uniform is selected, only the nail lengths and vertical spacing can be 
non-uniform; other nail properties will still be uniform throughout the wall.  
 
For both uniform and non-uniform nail geometries, a Properties tab allows the user to enter 
general data about the nails.  This includes the nail length (for uniform nails only), horizontal 
nail spacing, vertical nail spacing (for uniform nails only), nail inclination, drill hole diameter, 
nail bar size, nail bar yield strength, nail bar shear strength, cantilever distance between the top 
of the wall and the top nail, and the strength factors for nail pullout, tendon tensile failure, and 
head strength.  Both nail bar cross-sectional area and diameter must be entered, which allows for 
the use of hollow-bar nails in all subsequent calculations. 
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Please note: nail length in SNAP is defined from the back of the shotcrete facing to the end of 
the steel nail tendon, for both shotcrete and cast-in-place facing types.  Nail length is measured in 
the direction of the nail inclination.  
 
In the display area, the variation of allowable nail bar load along the length of the nail is shown 
as a blue line just above each nail (similar to Figure 2  in Chapter 1).  Depending on the location, 
this line may correspond to the allowable nail head strength, the allowable nail bar tensile 
strength, or a reduction of the tensile strength based on the allowable pullout strength between 
the grout and the soil.  This line is essentially a small graph, based on the nail and soil properties 
entered on the Soil, Nail, and Wall Facing tabs.  (The nail head strength will be zero until wall 
facing information is entered on the Wall Facing tab.)  When SNAP calculates global stability 
for the wall, these graphs are used to determine the resisting forces contributed by each nail.  
 
For uniform nail geometry, the user may change the length or inclination of a nail by entering 
values into the Properties tab, or using the mouse to drag the end point of the top nail (displayed 
in bright purple) around the display area.  The lengths and inclinations of all of the nails will 
automatically change.   
 

 
 

Figure 35.  Screen Shot.  Change uniform nail lengths by clicking and dragging the top nail 
around the display area. 
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For uniform nail geometry, the Uniform Nail Settings tab displays the height of each nail above 
the toe of the wall (the toe of the wall is by default Z = 0).  When the user selects a nail in the 
table on the left, the allowable nail support load variation is summarized in a table in the lower 
portion of the frame.  The nail support load diagrams are also shown in the display area, along 
the length of each nail.   
 

 
 

Figure 36.  Screen Shot.  The “Uniform Nail Settings” tab displays nail heights above the 
toe of the wall and support load diagrams. 
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For non-uniform nail geometry, the Nail Settings tab allows the user to change the length and 
height above the toe of the wall for each nail (the toe of the wall is by default Z = 0).  Individual 
nail inclination may also be adjusted if a different orientation is required for any row of nails 
(e.g. in the case of an underground utility in conflict with wall construction).  The overall nail 
inclination value on the Properties tab will show the minimum inclination value from the Nail 
Settings tab.   
 
All settings values may be entered into the table or the user may click in the display area where 
the end point of a new nail should go, and a nail will be added.  When a nail is selected in the 
table or when the user hovers over a nail in the display area with the mouse, the nail support load 
diagram for that nail is summarized in a table in the lower portion of the left frame.  The nail 
support load diagrams are also shown in the display area along each nail.   
 

 
 

Figure 37.  Screen Shot.  The “Non-Uniform Nail Settings” tab displays nail lengths, 
heights, and inclinations, as well as support load diagrams. 

 

Additional Information on Nail Support Load Diagrams 
 
FHWA Publication No. FHWA-SA-96-069R includes a helpful example of a nail support load 
diagram, reproduced as Figure 2 on page 5 above.  This diagram is used to visualize how a soil 
nail’s contribution to global stability varies along the length of the nail.  Where a potential slip 
circle intersects the nail along the nail’s length determines how much additional strength will be 
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available to resist failure.  The closer the intersection is to the front or the back, the more likely 
the nail is to fail in pullout.  If the nail is long enough, then the nail’s tendon tensile strength may 
be the contributing force at locations near the center of the nail tendon, rather than the pullout 
strength between the soil and the grout around the nail.  The nail head also contributes some 
strength near the front of the nail. 
 

Nail Length Handicapping in SNAP 
 
FHWA-SA-96-069R outlines a procedure for “handicapping” or “shorting” soil nails near the 
bottom of a wall during design, in order to ensure that adequate nail reinforcement is installed in 
the upper portion of the wall.  Performance monitoring of several instrumented soil nail walls has 
demonstrated that the top-down construction method of soil nail walls generally results in the 
nails in the upper part of the wall being more critical than the nails in the lower part of the wall 
in developing resisting loads and controlling wall deformation.  If stability calculations overstate 
the contribution from the lower nails, then this can erroneously specify shorter nails or smaller 
tendon sizes should be used in the upper part of the wall.  This is detrimental and could result in 
poor wall performance.  The procedure given by FHWA (in Section 4.7.1) is summarized in 
Figure 38 below.   
 
In SNAP, this can be done manually by the user, by using the Non-Uniform Nails feature in the 
Nails tab.  The user can select appropriate lengths to analyze global stability based on artificially 
shortened nails.   
 
Please note that this design procedure is only for use in designing the wall; it does not indicate 
that the installed nail pattern should correspond to this pattern.  Soil nail walls are normally 
constructed with uniform nail lengths to simplify cost estimation and construction, although it is 
possible to install shorter nails in the lower part of the wall if external and global stability 
requirements are met.   
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Figure 38.  Schematic.  SNAP uses the nail handicapping procedure outlined in FHWA-SA-

96-069R. 
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Seismic Data 
 
Seismic effects are ignored when “Include Seismic Loading in Analysis” on the Seismic 
Coefficients tab is not checked: 
 

 
 

Figure 39.  Screen Shot.  Un-check this box to do a normal analysis without seismic effects. 
 
 
To include seismic effects, check the box next to Include Seismic Loading in Analysis.  Enter a 
value for the horizontal seismic coefficient Kh, or enter the peak ground acceleration, A, and 
obtain Kh from the Calc Kh from A button. 
 

 
 

Figure 40.  Screen Shot.  You can enter two types of seismic coefficients: Kh or Peak 
Ground Acceleration. 

 
This calculation is based on a tolerable seismically-induced lateral wall movement, as outlined 
by FHWA-IF-03-017, Section 5.4.5.3.  Including seismic loading will affect results for external 
stability and global stability.  For conservative calculations, SNAP always assumes that the 
vertical seismic coefficient, kv, is zero, for both external and global stability calculations.   
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Facing Data 
 
The Wall Facing tab provides the user with two options for facing types: Shotcrete and Cast-in-
Place.  When Cast-in-Place is selected, the strength of any shotcrete facing that would be 
constructed behind the cast-in-place facing is neglected.  FHWA guidelines recommend this 
since a shotcrete facing is often only designed for a temporary loading condition.  
 
Two common nail spacing patterns can be selected: Offset and Square.  This does not affect any 
calculations, and is for display purposes only.  Both nail patterns may be selected for either 
Shotcrete or Cast in Place facing types.  An offset pattern is shown in Figure  41. 
 

 

 
 

Figure 41.  Screen Shot.  An “Offset” nail installation pattern is selected on the Wall Facing 
tab. 
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Selecting a square pattern results in the following: 
 

 

 
 

Figure 42.  Screen Shot.  A “Square” nail installation pattern is selected on the Wall Facing 
tab. 
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For a shotcrete facing, the user enters input information about the wire mesh, horizontal waler 
bars, vertical bearing bars, shotcrete, and bearing plate.  SNAP calculates the nominal nail head 
strength for both punching and flexure, selects the controlling mode, and calculates the allowable 
nail head load based on this value.  All of these are displayed at the bottom of the list.   
 

 
 

Figure 43.  Screen Shot.  The nominal nail head strength, TFN, and allowable nail head 
load, TF are displayed at the bottom of the list for a shotcrete facing. 
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Design checks for the shotcrete facing are included in a separate Shotcrete Design Checks tab, in 
the rows with small blue “information” icons.  These can be viewed by holding the mouse over 
the icon for a few seconds: 
 

 
 
 

Figure 44.  Screen Shot.  Design checks for the shotcrete facing are viewed by holding the 
mouse over the blue icons.  
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For a cast-in-place concrete facing, the user enters input information about the horizontal and 
vertical concrete reinforcement, the concrete itself, and the headed-stud connection system 
between the concrete facing and the shotcrete facing.  SNAP calculates the nominal and 
allowable nail head load and displays it at the bottom of the list under the Cast-in-Place tab.   
 

 
 

Figure 45.  Screen Shot.  The nominal nail head strength, TFN, and allowable nail head 
load, TF are displayed at the bottom of the list for a cast-in-place facing. 
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Design checks for a cast-in-place concrete facing are included in a separate CIP design checks 
tab, in the rows with small blue “information” icons.  These can be viewed by holding the mouse 
over the icon for a few seconds: 
 

 
 

Figure 46.  Screen Shot.  Design checks for the cast-in-place facing are viewed by holding 
the mouse over the blue icons  

 
 


